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it

| Bullet Library T ~- Select the type of bullet point that you require
" e O ®m 4 o  fromtheBullet Library. In this case, you can
el e choose any symbol like the v. The bulleted list will

i v look like this.
E Document Blets i 7N\
e '

Define New Bullet...

Notice how
the bulleted list g
has been indented

Topics-covered-so-far-in-chapter-109q]

Whilststudying chapter10,1-haveiearnthowto:{

automatically in from the left v~enterdatafrom-an existing file{]

e N vskeyin-andedit-textq]
matgu.lj although 1,1(“ by ?‘t least vsimportimages froma-variety of sources
3 centimetres. To indent 1t v»place and manipulate images4
further, you need to change the v~setthepage size-and-orientation]

o . - v+setpagemarginsy
paragraph setting on the ruler. v+use headers andfootersf]

If the ruler cannot be seen at v+setpage, sectionandcolumnbreaksq
the top of the page, click on the vousecolumnsf
View Ruler i the rioht vasetfontstylesand-sizesy

iew Ruler icon on the righ /~emphasizing textf]
above the scroll bar. This will vausedists]
he

display the ruler at the top of t
page. (See Section 10.19 for more information on the ruler.)

Highlight all of the bulleted list. On the ruler, click the left mouse
button on the rectangle (not the triangle) and hold it down whilst
dragging the handle to the right. Make sure that both handles are
more than 3 centimetres to the right of the margin. The finished ruler
should look like this.

The bulleted list will now be indented like this. Save the file.

Topics-covered-so-fariin-chapter-10q

Whilststudyingchapiter10,{-haveiearnthowto:

v » enterdatafrom-an-existing filef

¥ » keyin-and edit-textq

v - importimagesfroma-variety of sources{
v - placeandmanipulateimagesq]

v o setthe pagesize-and-orientationy

v -+ setpagemargins{

v useheadersandfooters

v » setpage, sectionandcolumnbreaks 4
v » usecolumnsy]

v -+ setfontstyles-and-sizes

v/ + emphasizingtext{

v+ yseistsy
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Task 10k

Open the file saved in Task 10j.
Change the bulleted list into a numbered list using roman numerals.
Save the file with a new filename.

Open the file and highlight the entire bulleted
list. Select the Home tab, the Paragraph section
and click on the Numbering icon.

This will place numbers next to each of the list
items. To choose the type of numbering used,
select the drop-down handle instead of the icon.

Select the type of numbering that you require
from numbering library. In this case you
can choose the roman numerals as that was
specified in the task. Save the file.

Make sure that, if the bulleted list 1
contains short items that would make up Mone 2, (R b
the end of a sentence, it has a colon before 3
the list, each list item starts with a lower
case character and only the last item in the
list has a full stop.

Word will try to place capitals on each
list item, but this is not correct as ¢ach one
is not a new sentence. You must adjust
these to get a list looking like this.

T

. Pamgraph 0 B

Mumbering Lilirary

For breakfast | had:
e cereal

e toast

e acup of tea.
When it was lunchtime

<= Change List Level s
. Define New Mumber Format, ..

£ Set Numbering Value..

o

B mdalesbtng 3635
Activity 10h

&

Open the file TEXT4.RTF and place your name on the left, today’s date in the centre and the
filename on the right in the header. Make the blue text into a bulleted list, using a bullet of
your choice. Make sure that this bulleted list is indented by at least 2 centimetres. Make the
green text into a numbered list, using numbers followed by a bracket. Make the red text
into a bulleted sub-list, indented from the numbered list using different bullet points.
Change the colour of all the text to black.

Save the file with a new name.
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10.17 Using tables

Task [0}
Open the file that you saved in Task 10i. Add

. Maximum Minimum
to the end of the document the following 2nd Feb 3 3
text as a new paragraph: SrdFeb c =
‘Temperatures recorded at one weather ath Feb 5 3
station in Ross-on-Wye during the week =ih Feb 5 =
read:’. 6th Feb 2 -1
Below this add the table shown opposite: 7th Feb 5 3
Save the file with a new filename. 8th Feb 2 =

Tables of data may need inserting into your word-processed documents. You have
already inserted a table from a .csv file in Task 10a.

Open the file that you saved in Task 101 and add the text as a new paragraph to
the end of the document.

To create a new table you must first work out how
many rows and columns the table contains. By counting
them, you can work out that this table contains 3 columns
and 8 rows. Move the cursor to the correct place in the
document, then select the Insert tab, the Pages section
and click on the Table icon in the Tables section.
This will open the Insert

‘Pagsv Pagr:* E'eak ; "

{ InsertTable —a—

Table drop-down menu. Move _ 3xBTable B
the cursor over the grid until it OO0
highlights the three columns and - EHQE'D.-.DDD
eight rows that you need, like this. - H%d%%%%
Click the left mouse button in 000
the last highlighted cell of the grid o044
000 and this will insert a 3 by 8 table | I
Insert Table... ‘ into your document. Add the text I
Draw Table from the task into this table. You 3 Insert Table..
st Tast ta Tanic can move the cursor into the next Drawi Tabie
: Excel Spreadsheet cell bV PI‘CSSng the <Tab> I(Cy. If .
21 QuickTables » I you need more rows than the eight Excel Spreadshect

’ Qu:cy Tables >

<1V”111”1b1(. move the cursor into thg
last cell of the table and press the <Tab> key to create a new row. If you need lots of
new rows, hold down the <Tab> key.

Activity 10i

Create a new document with
the title 'Skills to practise using
tables'. Create this table, below

Function How Feature
Insert Insert tab Table

Right click | Rows

the title. Right click | Columns
Delete Rows
Format Celis Alignment Left, right, centre, fully justified
Top, centre, bottom
Colour, shading
Rows Breaks across page

Gridlines : Show
Hide

Text wrapping Cells
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Open the file TEXT5.RTF and place your name on the right in the header. Sec'ond
Delete the second column and the ‘Martial arts’ row. Insert a new third column choice
with this data. | 1
Insert a new row between the ‘Dance workshop' and ‘Discover Scuba’ with 2
this data. 21
18

Craftworkshop | 0 3 2 3 g
Merge cells 2 and 3 in the top row and cells 4 and 5 in the top row. 10
Save the file. 5

Open the file TEXT5.RTF and place your name on the right
in the header. To delete the second column, move the cursor

B Paste

to any cell in this column and click the right mouse button, to e

get the drop-down menu like this. > Delete Celts..
Select Delete Cells..., which will open the Delete Cells & salit Cells..

window. Select the radio button for Delete entire column L Borders and Shacing..

] It Texd Direction...
and click on o . i ection

Cell Alignment

Repeat this method to delete the | Delete Cells e
‘Martial arts’ row. Right mouse click ': zlt:mem“"'
in any cell in this row and select shift cells up 2 Numbering
Delete Cells.... This time select the Delete entire row B, Hpedink..
radio button for Delete entire row (_ Delete entire column & tookUp..
before clicking on _oc_. [ o ][ cancel :Z;?:::s
To insert a new third column,
right click the mouse in any cell in the 19
second column to obtain the drop- = B .18 5
down menu. Sclect Insert, then P e ‘ P et Cotumnstotnelett
g . Delete Cells... (b Insert Columns to the Right - i
Insert Columns to the nght.’{ S ot Cells.. 9 Insert Rows Abore f
will insert the column. Enter the text 3 Borders and Shading.. S Insent Rows Below %
shown in the task into the cells. it Test Direction... I nsert .. z
Use a similar method to insert the Cell Atanment g E)
new row. Click the right mouse L e ' 2

: . ¢ =4 Table onp‘ertiesm .
button in any cell in the ‘Dance

T pullets 3

workshop’ row. Select Insert, then 1= Numbering N
Insert Rows Below. This will insert & Ryperin..
the new row. Enter the text shown in & tooxUp..

Synanyms 4

the task into the cells.

Translate L
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Y X population Y population L To merge cells 2 and 3 in the top
First | Second second | row, highlight both these cells and
Activity | choice | Choice | Firstchoice  Choice | tjyep click the right mouse button on
Jewellerymaking | O 1 1 2 fthe highliehted cell I
. . oo
baintballing 39 > - 15| onc of the highlighted cells to get the
Boulogne trip 52 21 56 15| drop-down menu. Select Merge ——
Rockworkshop | 3 18 2 3| Cells. Repeat this for the two cells
— .
Danceworkshop | 0 2 10| placed to the right of the cells that
Craftworkshop | 0 3 2 3| you have just merged. The completed
Discoverscuba | 4 3 g 8 table should look like this. Save the
Beauty 4 10 1 9
— file.
| Ceramic painting_| 0 i 5 1 2

P

ivity 10}

Open the file that you saved in Activity 10i.
cheIettebThe top row and second column of _Betste Cells...
e table.
Insert a new row above the row containing Merge Celts
the word ‘Format’. Insert the text ‘Columns’ in | Horizontal
cell 2 of this new row. Insert a new fourth Vertical
column with this data. —_—
In column 1, merge the cells containing , )
‘Insert’, Delete’ and ‘Format’ with the blank | AutoRit '
cells below them. In column 2, merge the | Table Properties...
cells containing ‘Cells’ and ‘Gridlines’ with
the blank cells below them. in column 3, merge the cell
containing ‘Alignment’ with the blank cell below it.
Save the file with a new name.

[o ¥

Borders and Shading...
. Text Direction..,

elt Alignment *

Tables can be formatted so that they can be aligned left, right or centrally between the
margins. Text can be wrapped around the table or not as required. These features are
found in the table properties: click the right mouse button in the cell of the table, then
select Table Properties... and the Table tab within the Table Properties window.
The table alignment can be selected in the Alignment section and text wrapping
around the table can be switched on or off in|the Text wrapping section.

Cells can be formatted
so that the contents can be aligned both
horizontally and vertically within the cell.
Horizontal alignment can be set and N lerefnedwan: |
changed by highlighting the relevant cells, Hamen:
selecting the Home tab and the Paragraph || B
section and using the alignment icons within — =
that section. See Section 10.18 for more
details.

Table Proparties.

Ren_[coumn | cear |

Indant from fefl:

0am e

&
rai

2

teft Center

Hone Around

n
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Task 10n

Open the file that you saved in Task 10m.

Right align all of the cells containing numbers in the second column. Centre align all of the
cells in the top two rows.

Set the background colour of all cells in the top two rows to yellow. Ensure that there is no
text wrapped within the cells of the table. Vertically align all data to the top of each cell.
Remove the gridlines from any unused cells.

Save the file with a new name.

To right align the numbers in =~ | [ Xpopulation | Y population
the second column, highlight ——_ First Second Second
these CCHS, then select the Aligll m\ choice | Choice | First choice | Choice
io} —— it Jewellery making 1 1 2
Text Right =& icon n the Paintballing 3 P 19
Paragraph section under the Boulogne trip 21 56 18
Home tab. Repeat this method Rock workshop 18 2 3
to centre align the cells in the top | Danceworkshop 2 2 10
two rows: highlight these cells Craft workshop 3 2 3
and click on the Center = icon Discover scuba 3 8 g
‘ R | Beauty 10| 1] 9
in the Paragraph section. While Ceramic painting 5| 1 2|

these cells in the top two rows are
highlighted, select the Home tab, in the Paragraph
section and click on the drop-down list for the Shading
tool. Select the yellow colour from the palette, which
will set the background colour for these cells.

To ensure that there 1s no text wrapped within the
cells of the table, the column widths of the table need
adjusting to fit the text within them. Make sure no
cell within the table is selected before placing the
cursor over the gridline between the cells. This cursor

~will change to appear like this. Without moving the ;
mouse, double click the left mouse button. Repeat I
this for each column that needs resizing. Make sure
that the completed table does not fit outside the
margins of the page. This will be
penalised in the practical examinations.

Emphasis Hi

Mo Color

More Colors...

b X population L Y population
First | Second Second
Activity choice | Choice | First choice | Choice
Jewellery making 0 1 1 2
Paintballing 39 2 37 19
netrip 52 21 56 18
Rock Workshop——tw——__3 18 2 3
Dance workshop o " 2 2 10
Craft workshop 0 3 2 3
Discover scuba 4 } 3 8 } 8
Beauty 4] 10 1] 9
Ceramic painting 0 \ 5 1 ‘ 2
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10.18

Table Properties

[ Table. [ ow_ [ colamn | Cell 11

To vertically align all data to the top of
cach cell, highlight all the cells that require
this. Right mouse click in the table, select
Table Properties..., and sclect the Cell tab.
Select the option for Top and click on o

To remove the gridlines from the unused
cell in the top left corner, right mouse click
in that cell of the table and choose Borders
and Shading... from the drop-down menu
to open the Borders and Shading window.
Select the Borders tab.

— Click the left mouse button on each of

the lines that you wish to remove and in the

Apply to: section select the option for Cell
|

Size
9] Preferred width: 4’08cm ——:~ Measure in: }éenﬁmeters E

é Vertical alignment

==

Top Center

=

Bottom

Borders and Shading ’ Table Properties

E'Iable | Row ‘E—lg’mn I Cell ]

‘ o
| Rows .]
i Size

i
) spedfy height:
Oplions

[} Allow row to break across pages

i Preview

Click gy diagram bftow or
ttons to apgfy borderf

i NRpez adar row at the top of esch page

@ PreviousRomN |2 NextRon.

Horizontaltine .

from the drop-down list, before clicking on _o_. Remember to remove the yellow
background from this cell, using the method shown earlier in this section.

Sometimes, when text wrapping is present, a table row and its contents will be split
between two different pages (or columns). To make sure that this does not happen,
highlight the entire table, right mouse click and select Table Properties..., then the
Row tab. Remove the tick from the Allow rows to break across pages tick box and
click on _ox_..

B pdringyday 4 £33
Activity 10k

Open the file that you saved in Activity 10j. Right align all the cells in the first column. Left align
all other cells in the table. Set the background colour of all cells in the first column to light grey.
Ensure that there is no text wrapped within the cells of the table. Vertically align all data to the
middle of each cell. Remove the gridlines from any unused cells. Save the file with a new name.

Text alignment

Text can be aligned in four basic ways. It can be aligned:

@ to the left margin with a ragged right margin which is called left aligned
® to the centre of the page, which is called centre aligned

@ to the right margin, which is called right aligned

@ to both margins which is called fully justified.
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10.19

As you saw in Section 10.17 the text is aligned by selecting the text and then
using the using the alignment icons. These icons are found in in the Paragraph
section under the Home tab.

Centre Right Fully
alngned aligned aligned justified

= 5 A
FiVotn “wa vy i@Q

ey
Open the file TEXT6.RTF and place your name in the centre of the header. Make only the title a
36 point sans serif font that is centre aligned and fits in a single, full width column. Move the
third paragraph so that it becomes the last paragraph. Fully justify the body text. Centre align
the second paragraph. Left align the third paragraph. Right align the fourth paragraph. Make
the first word ‘grew’ in the story 16 points high, the second ‘grew’ 20 points and the third ‘grew’
24 points. Save the file with a new name.

Line spacing

Emphatis H

Ditterent line spacing can be used to present
different page layouts. The most commonly used
layouts are single line spacing, 1.5 line spacing and
double line spacing. To change the line spacing in a 20
paragraph, select the Home tab, and look in the
Paragraph section to find the Line spacing icon.
Select this icon to open this drop-down menu. —
Although you can change the line spacing of a - line Spading Dptions..

&

T

paragraph from here, select Line Spacing
Options... to open the Paragraph window, which
gives you more options.

To change the line spacing, select
the Line spacing: drop-down menu.
This will allow you to define an exact
number of lines, which 1s very useful
for title pages, where lines may be
spaced out, perhaps needing to be five
or six lines apart.

Add Spage Before P gra;ab

Add Space After Paragraph

‘Paragraph

K . . Indentation
Ensuring that line spacing ona page ||| s vam spedl o
IS consistent is just as important as I en e =]
setting the line spacing. It is often wise [Pl varar indents o
to select all text and adjust the line
. i Spacing

spacing together. If yvou move, copy

p( = g A > P“ ’ Before: Line spaang

msert or delete text from your
document, always check that the line
spacing is correct after you have made
any change. Each paragraph and
heading can have the spacing before and /
after it sct using the same Paragraph il
window. This is sct in the Spacing E
section, where the space before and [l l
after any paragraph (a title is counted as ?L Ts.. | [ Dekdt. | oo, ) [ canea |l
a paragraph) can be edited.

After: Smgle

ace between paragraj eSS SRRy
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Activity 10m

Open the file that you saved in Activity 10l

Make the first paragraph single line spacing, the second paragraph 1.5 line spacing and the
third paragraph double line spacing. Do not change the line spacing in the rest of the
document.

Set the heading spacing to 12 spaces before and 24 spaces after the paragraph.

Save the file with a new name.

Paragraphs can be formatted with different settings for the first line of a
paragraph and the other lines in a paragraph. These settings are all changed on the
ruler, which looks like this.

\

On the left side of the ruler are two settings for the left margin. The rop triangle
adjusts the first line of the paragraph, the bottom triangle aligns the rest of the
paragraph, and the rectangle below moves the whole paragraph.

Task 100

Open the file TEXT7.RTF and place your name on the left in the header.

Set the first line of the first paragraph as indented text, indented by 2.5 centimetres. Indent
the whole of the second paragraph by 2.5 centimetres. Set the fourth and fifth paragraphs
as hanging paragraphs with a 2.5 centimetre tab. In the fifth paragraph make the text
‘Good Use’ a sub-heading.

Save the file with a new filename.

Open the file and place your name in the header. Click the left mouse button in the
tirst paragraph. Drag the top triangle to the right by 2.5 centimetres, like this.

To indent the whole of the second paragraph, click in that paragraph and then
drag the small rectangle across to the right by 2.5 centimetres, like this.

Highlight both the fourth and fifth paragraphs and drag the bottom triangle to
the right by 2.5 centimetres, like this

To make the text ‘Good Use’ a sub-heading, remove the full stop and space at the
end of it and replace it with the <Tab> key.
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10.20

Activity 10n

Open the file that you saved in Activity 10g. Add the text ‘History item 1" as a new line to the start
of the document. Format this text in the same style as the rest of the page. Change the title
‘Weather update’ to ‘February 2009'. Set all of the text on the first page to be spaced 5 lines
apart and all other text in the document to be single line spacing with no spacing before each
paragraph and 24 point spacing after each paragraph. indent first line of each paragraph on the
second page by 5 millimetres. Save the file with a new name.

Correcting errors

You will need to spell check all word-processed documents before L e
submitting them for assessment. Select the Review tab and in the
Proofing section click on the Spelling and Grammar icon. The spelling |
and grammar check starts automatically. Any words or phrases found in a
document that are not in the dictionary will be flagged as an error. Do

not worry about the differences in

Spelling Ev. i
| Grammar

SpCHing that can occur Wlth Spelling and Grammar, English (United Kingdom) -
dictionaries from different regions, Notinpictonary, i S

o s ¢ 5 mout-med\ff&rmcasmspdhng- A—K +Ignore Once.. |
tor example ‘centre’ and ‘center’; that-can occur-with-dictionaries-from -different- L2

- iregions, for-example-centre; ente:{'these'
sed-inthe-examinations.-

these should not be penalised in the
examinations. For example, this has —
been flagged as an error, but was
put into the text intentionally. Be
careful not to change the spelling of
names, especially for, companies,
people or places. Each time an error
is flagged, read it carefully and
decide whether to change or ignore 7

the spelling, using the buttons in the window.

It is important that you also read through all of the work and make sure that the
text or data that you have typed 1s 100 per cent correct. A large number of marks
can be lost in practical examinations through careless checking of your data entry.
Check that your documents have consistency in all areas, not only fonts and styles,
but also in line spacing and paragraph spacing. It is very easy to follow the
instructions on a question paper, for example to remove a page break, only to find
that you have an extra carriage return later, which will lose the consistency marks
awarded for the document. If you have inserted section breaks or page breaks, make
sure that there are no blank pages.

Part of the proofreading and error correction will be to check for widows and
orphans. Even though you may have applied automatic widow and orphan control,
it is always good practice to check that these have been removed. It is possible that
you did not apply it to every paragraph. Make sure that other objects, like bulleted
or numbered lists, tables, graphs and database or spreadshecet extracts are not split
over two pages. Again, inserting appropriate breaks should avoid these problems.

. Add to Diclionary




CHAPTER

Data manipulation

In this chapter you will learn how to:

understand database structures

. Create a database from an existing data file

define database structures

enter different forms of data into a database

search for subsets of data

produce a report

export data and reports for use within another package
use formulae within a database

sort data within a database.

k-

For this chapter you will need these source files from the CD:
@ CARS.CSV
STATIONERY.CSV

111

Understanding database structures

Traditional flat-file databases store data using a system of files, records and fields:

@ A field is a single item of data like a forename or date of birth. Each field has a
fieldname, which is used to identify it within the database. Each field contains
one type of data, for example numbers, text, or a date.

@ A record is a collection of fields, for example all the information about one
person or one item. These may contain different data types.

@ A file (in database terms) is an organised collection of records, usually where all
the records are organised so that they can be stored together.

You will be using Microsoft Access, which is part of the Microsoft Office suite. Access
stores its data in the form of tables, which are organised by rows and columns. Two
or more of these tables can be joined together because Access is a relational database,
rather than a flat file database, but this is beyond the scope of the practical section of
this book. Each row in a table contains a record. Each column in the table represents
a field and each cell in that column has the same, pre-defined field type.

Field types

When you create a new database you will set each field a field type. The field type
will tell Access how to store and manipulate the data for each field. You will usually
decide what field type should be used for each field. There are a number of field
types that you can use and different packages may have different names for these.
The list below shows the generic names for these field types (these will probably be
used in the examination qucstlons), but depending upon the package used, you may
have different names. For example, in Aecess an alphanumeric field is called a text
field. The three main types of field are alphanumeric, numeric and Boolean:
@ Alphanumeric data can store alpha characters (text) or numeric data (numbers)
that will not be used for calculations. In Access this is called a text field.
® A numeric field type (as the name suggests) is used to store numeric values that
may be used for calculations. This does not include numeric data like telephone
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numbers which should be stored in an alphanumeric field type. In Access this is

called a number field. There are different types of numeric field including:

@ integer fields, which store whole numbers. In Access you can select an integer
field or a long integer field. It is wise to use a long integer field if it is going to
contain three or more digits

® decimal formats, which will allow a large number of decimal places, or a
specified restricted number, if this is set in the creation of the field properties
when the database is set up

@ currency values, which allow currency formatting to be added to the display.
These include currency symbols and regional symbols. The database does not
store these as this would use up valuable storage space

& date and time formats, which store a date and/or time as a number.

7

@ A Boolean (or logical) field type is used to store data in a Yes/No (or True/False,
0/1) tormat.

There are other field types as well, like a memo type but these are not available in all

el
packages, so will not be in the practical examinations. As stated above, you will be using
Access. Microsoft Excel 1s not suitable for database tasks as you can not define field types.

Taslclia

You work for a small garage called ‘Dodgy Dave’s Motors'. This garage sells used cars. Using
a suitable database package, import the file CARS.CSV. Assign the following data types to

the fields.

Who manufactured the car? Text

Model Text

Colour Text

Price that we bought the car for Numeric/Currency/2 decimal places
Price that we will sell the car for Numeric/Currency/2 decimal places
Year Numerid/integer

Extras Text

Does the car need cleaning? Boolean/Logical

Some fieldnames are inappropriate. Create appropriate and meaningful fieldnames for
those fields, You may add another field as a primary key field if your software requires this.
Save your database.

It is important to make sure that you use the fieldnames exactly as given in the
question paper, unless you are asked to provide appropriate and meaningful
fieldnames. In this task you are asked for appr opriate and meaningful ﬁddnamcs SO
start by looking at the detailed descriptions given instead of the fieldnames, or even
examine the data to work out what information the fields contains.

For this task, the descriptions help you to work out meaningful tieldnames. These
should always be short enough to allow printouts to fit casily onto as few pages as
p()SSIbl(, Thc first L\amp ¢ 1s #; this could be shortened
to &1 1s short, meaningful and appropriate, so use
that. Thc could be changed to :
. Although Acwss will allow any of these,

o or just
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11.2 Creating a database from an existing file

Hint

Check that the data
files are in the
correct format for
your regional
settings before
attempting this
section. (See
Introduction,

page xi.)

do not use ficldnames with spaces in, as they may cause problems if you try to do
more complex operations with the database. You could use any of the other three

options, as all would be acceptable. For this task, use

». For the final field,
could give the wrong idea, as it could mean ‘Does the car
nccd cleaning?’ or “Is the car clean?”. In this case you can use *

field can be called ¢
using the fieldname

. Similarly, the next
’, simply

as the fieldname

to avoid confuswn It is sensible to plan this and make the changes in the.csv file,
before importing the data into Access.

Open the.csv file in Excel. Move into the relevant cells and type in the new
fieldnames. Check the spelling carefully before re-saving the data file. Save it with
the filename carsl.csv so you do not lose the original data file. Task 11a is continued

in the next section.

.
Jo

Open Access and use the Office button followed by New to open the Blank
— Database pane on the right-hand side in the window. Enter a File Name:
for the databisc for example ‘cars’ or a similar meaningful filename, and click on
}. This shou d open a new database similar to this.

\

| Create.

Blank Database

Create a Miaresoft Office Arcess database that does
not contain any existing data or objects,

fle

Ci¥sers'Graham'Dossments’,

i

fogeae ] [com |

“PatEshieet View

cars: Ua{ab::e (Access 2007) - Microsoft Acce.., . Table Tools

< BeiiOate | Databdse Tudli “Z¢ patasheet

i Inset DataTyper, ) -

View bt Add Existing Lookup

Refationsnips  Object
Fld  Fields  Column

Depends

AlTables oo
Tablel
T Ttablet : Table

o4 Houmtede

bder[: anxa

cars s Diatabase (Access 2007) - Microzoft Acce... :* 1able Tools

To import the file
CARS1.CSV (remember
we saved it with a new
filename in an carlier
section) for the task, select
the External Data tab.

Specfy how and vhere you it ta stare the data i the arrent dytabase.

& [mport the aiirce dats Into a new table In the current database,

’&Wm&d.abtcdcum £ exiat, A@r}"ﬁc’cufgm if the spaotied e
it ks

rents 0417 TextbodkiChiste 11VAorked copericeralesy

Click on the Import text
file icon, as files saved
in.csv format are text files,
with each data item
separated from the next by
a comma. This icon opens the Get

€ Append 3 copy of the recards to the table:

if the spacifiad vabie existy, Atcess ved add the recerds o %
 the source dats i ot be refacted i e databiage,

#1 Link to the dats source by creating 4 fnked table.

External Data window like this.

Use the button to find

Accezs vl ceste 8 table that vl intn 3 fk D the sarom data. ¥
Horever, you can 383 new recads,

oot ot s S, the file CARS1.CSV and ensure
that the top radio button is
selected. This will ensure that the
data is savcd nanew data table.
Click on =




Information and Communication Technology

Hint

A large number of
students perform
poorly on these
questions in
examinations
because they select
the bottom option
to link the database
to data held in a
spreadsheet.

The Import Text

2] Import Text Wizard

Wizard window will
open. As comma

Your data seems to be in a Debmited’ format. If it is't, choase the format that more correctly
desaribes your data.

Y

separated value (.csv)
files are delimited files
(the comma is the
delimiter), select the —
Delimited radio button
and click on gNext> .
For the next part of
the wizard, make sure
that the Comma is ——
selected using the radio
buttons (unless you

BDe - Characters such s comma of tah separate each fiekd H
£ Fixed Width - Fields are a3gned in columns with spaces between each field

ple data from fle: C\ISERS\GRAHAMYDOCUMENTS 0417 TEXTBOCK\CHAPTER 11WORKED COPIES'CARS 1.CSV.

ake,Hodel, Coloux, PPrice, SPrice, Year, Extras,valet

[[VR, Tuscan, Black, 18000, 2030S,2006,Alloy Wheels Air Conditioning,N
Mercedes,C200, Silver, 4995, 5995,2003,Air Conditioning ,N
royota,MR2 roadstex,Electric blue,13995,15895,2005, Leather Seats
B, 23, Metallic black, 4665,5635,2000,All0y Wheels N
foyosa,Celica, Red, 21995, 24695, 2008, Air Conditioning  Alloy Wheels,¥
Rudi, TT,Black, 15495,17545, 2007, Central Locking Leather Seats
Mercedes, E320 ,Silver,11450,13095,2007,Air Conditioning M
Mini, Cooper, Green, 12500, 14255,2008, Central Locking  Leathexr Seats
auxhall,Astra Herit,Black,1695,2365,2003,Air Conditioning ,N
Ford, Escort,Dark blus,2395,3135,2003,A1loy Wheels N
Bubaru, Legacy, Silver, 3995, 4895,2003,Air Conditioning
nault,Clio, Dark blue, 399S,489S,2006,A1r Candizioning
Foxd, Mondeo, White, 18750, 21125,2009, ,N
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Air Conditioning, M

Alloy Wheels,N

Air Conditioning
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have changed the.csv

file so that it uses semi-
colons as delimiters).
Examine the first row
of the data and decide
whether this row
contains the fieldnames
that you need or if it
contains the first row
of data. If the first row
contains the fieldnames
click on the First Row
Contains Field
Names tick box. As
you tick this box the

2] Import Text Wizard

‘What debmiter separates your

dokmiter and see h

Chaase the delimiter thatsepa{atﬂ bvour fieids:

your textis affected in the preview below,

oI ) Semicolom
/I First Row Contains Field Names.

fake fodel olour Pprice pprice fear Fxcras <=t
[TVR ruscan lack RB00O P006 Rlloy Wneels Air Condxtxonianj
ercedes [£200 5iiver loaos 003 Rir Conditioning
[foyota HR2 roadster Electric blue [13895 k00s Jeather Seats Rar Condizioning
B &] fetallrc black {665 000 piloy Wheels
[Foyota [felica ed R199s P0O8 Pir Conditioning  Alloy Wheels
ud rT lack 5495 P007 fentral Locking  Leather Seats
ercedes E320 Silver [L1450 2007 Rir Conditioning
ini kooper reen 12500 pooe Fentral Locking Leather Seats
uxhall fstra Merit PBlack 695 P003 pir Conditioning

i Ford Escort ark blue 395 R003 hlloy Wheels
Fubaru [Legacy ilver B99s 003 pir Conditioning  Alloy Whaels
Renault Elio ark blue oes Roo6 Rir Conditioning
Ford andeo hite ne7s0 009 Rl

2

first row changes from -

this, to this.
L
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|
28] tmport Text Wizard
What delimiter separates your fields? Select the appropriate defimiter and see how your text is affected in the preview befow.
Choose the defimiter that separates your fields:
) Tab &) Semicolon @ Comma & Snace & Other:

Eﬂiﬁrst Row Contains Field Names Text Qualifier:
Make Model Calour PPrice |SPrice |Year |Extras
m Fuscan Black 8000 0305 006 plloy Wheels Air Conditioning
Mercedes 200 Silver 14995 5995 R003 Pir Conditioning
foyota MR2 roadster Electric blue [13995 25895 2005 [Leather Seats Air Conditioning]
BMW b3 erallic black HB665 635 000 Rlioy Wheels
[foyota Caelica Red 1995 [R4695 PROOE Pir Conditioning Alloy Wheels
Audi 1y Black BS5495 (17545 R007 Lentral Locking Leather Seats
Mercedes [E320 Silver 11450 [13035 [RO07? Rir Conditioning
Mini l-ooper |Sreen 12500 [14255 [R008 Kentral Locking Leather Seats
fauxhall Rstra Merit plack L6935 2365 P.003 fiir Conditioning
Ford Escort Park blue R395 13135 2003 Rlloy Wheels
lSubaru iLegacy Filver 3995 11895 2003 Puir Conditioning Alloy Wheels
Renault Klio Park blue SEEE 1895 006§ pir Conditioning
Ford ifondeo fiihite 18750 R1125 [ROOY
Ford Fiesta Blue 700 575 2009 LCentral Locking Air Conditioni
A 2
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Data manipulation

:] Carsl Import Specification

Click on . Advenced....

to open the Import—___ |

Specification window. Flefomet S e
Check that all the fieldnames and data types
Language: Englon
icre e Eamn 00 ]

rnatch those specified in the task. In this case the |
rice and - fields are not correct. |5
The cand & tields need changing to
numeric (currency) fields and the ﬁeld
needs changing to a Boolean (Yes/No) field.

To change the field into a numeric e ::;?mm fie M—
field with a currency sub-type, click on the Data || |= == om0
Type cell for this field and use the drop-down | | [Jis lisas e
list to select the Currency field type. Repeat Cam —

this process for the &1 field.

For the * field, use the drop-down list to S
change the Text ficld type into a Yes/No field type. ou Dyt Yeors
When all of these changes have been made, click on :;";";i:"““”“‘f

. Select test>. twice. In the next screen, ensure "~ [snoe R
tlnt the radio button for Let Access add primary §§E§i§m= g
key is selected — this adds a new field called ID to OLE Object
the table and Access will use this as the primary key e TR
field. Click on -text> and in the Import to Table: | Long ot Tri
box, enter tblCars. This is a meaningful table name, o o F

as ‘tbl’ shows you that it
is a table and the “‘Cars’
gives relevance to the
data. Click on _gmish._.
import the data - and on

%«% 5 nt “Fitter ‘3

The icon in the
Views tab will let
you change

between Datasheet

and Design View.

; . to close the
wizard. Double click on
tblCars to display the

PPrice.
£18,000.00

Colour
Black

R '(blCar;:ﬁhie Tusean

table like this.

cm: Oatabase (Acc:n 2007) - Microsoft A::c

? X Detete Rows
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Text
Text
Text

Currency

Yes/No -
Fitig hroedties

{Format

[ Decimarpiaces

Pinput dazk |
[ Captian

i Detautt value
[validation Rute
| Validation Tedt

| Required

| Indexed

g Smart Togs.
{Text Align

"2 Mercedes C200 Silver £4,995.00
3 Toyota MR2 roadster Efectric blue £13,995.00
4 BMW 23 Metallic black £4,665.00
5 Toyota Celica £21,995.00
H &. L. £15 495 na
|| Record: W s1of68 1 b M b | g
- Dstkteet Viewr oo e v

Test 1~ mouse button in the &

Changes to the field types or other properties, can be
changed from the Home tab. In the Views section,
click on the Design View icon.

The task instructed you to set the
ice field to 2 decimal places. You
can check this by clicking the left

*vice field and

viewing the number of Decimal

b1 Afieid mame can be up fo 63 tinsders fong,
inctuding fpaces. Préss Fi fontteip opfield
nEmR.

“Generat |

Places in the General tab at the
bottom of the window.

As you can see this 1s not set to
2 dccmml places but is set to
automatic. Click on the cell containing
Auto and use the drop-down list to set

Format .
Decimal Places
input Mask
Caption
Defauht Valuz
\vatidation Rule,

Vali ] 3
this to 2 decimal places. Repeat this — e’ g
process for the ¢ - field. Eigtiy %;
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Hint

If you need
percentage values,
set an integer or
long integer field
type and select
Percentage from
the Format drop-

down menu for this
field.

11.3

o Make ¢ Model -
1TVR Tuscan
2 Mercedes C200

v

To change the Boolean field so that it displays Yes
or No (it does not store the data like this), click in_»=
the Valat field and in the General tab select the
Format cell. Use the drop-down list to select the
Yes/No option. Save the database for later use.

Text
Yes/No
Field Prop.

‘Caption
‘Detault Value

Validation Rule :
[ 1Validation Text B S
Indexed No o o
TextAlign General |

H

Activity [ la

You work for a shop selling office supplies called 'Easy as ABC'. Using a suitable database
package, import the file STATIONERY.CSV. Assign the following data types to the fields.

Code Numerid/Integer

Type of product to be sold Text

Description of the product to be sold Text

Quantity of items in each pack Numerid/Integer

Colour Text

Sales Price Numeric/Currency/2 decimal places
Purchase Price Numeric/Currency/2 decimal places
Discount

Boolean/Logical

Some fieldnames are inappropriate. Create appropriate and meaningful fieldnames for
those fields. Use the Code field as your primary key field. Save your database.

Entering data

Task ilb

Open the file that you saved at the end of Task 11a.
Add this new car to the database.

Make | Model | Cofour |PPrice SPrice Year Extras Valet

Ford | Escort | Silver 4350 5285 2002 Alarm Central Locking

Alloy Wheels

Data would normally be entered into a database using a torm,
but in the practical examinations it is probably better to use the
table to enter new data.

Open the database saved in Task 11a. Double click the left
mouse button on the table name to open the table in
Datasheet View.

To make sure that all the columns are fully visible, click the
left mouse button on the small white triangle to highlight the
entire datasheet. Move the cursor between two
fieldnames until it looks like this and then double
click. This will adjust the display widths ot the
columns. Scroll down the list of cars until you reach
the entry with a star next to it which will allow you to
add a New car at the bottom.

T s Tare

Rodst -
Passat

Escort

Colour
Black
Silver

A
2005
2004 AirConditioning Cantral Locking

£5,455.00
£3,450.00

£7,645.00
£4.235.00

»e {Nawr)



Data manipulation

Click the cursor in the ¢ cell for the new car and add ‘Ford’. The new ID
number will automatically appear in the tield, as you set this field as an
AutoNumber type. Move the cursor and enter the | and
in the same way. You can always use copy and paste for some data. For example, if
you need to make sure the spelling of Escort is correct, copy and paste it from
record 67 above. For the e and - fields, enter only the numbers (and
decimal point if this is required). Do not attempt to enter any other characters like
the currency symbol. As you press the <Enter> key after 1ddmcr the prices Access
will set the data into currency format. The Valer field will mtom"ttlmlly default to
No. Move into this tield and enter Yes in this cell. As you enter each item of data
Access will automatically save it.

Check your data entry carefully using visual verification. This is when you
compare the original data on paper (in this case, in Task 11b) with the data that you
have entered into the computer. Any data entry error in a database may cause you
errors when you try to usc the database to search or sort. Save the database.

Add a new field to the database called PDate. Add the purchase date of 30 September 2009
for the next record.

Open the database and open the table
tblCars in D651g11 View. Move to the empty
row below the Vzicr field and enter the
Fieldname : E
In the Data Type box use the drop- down\ e
list to select the Date/Time type.
Choose the most appropriate Format for
the question. In this case, the task asks for a
Long Date format.
Save the database and select the
Datasheet View. Move the cursor into the
PDate field for the new record (the Silver Ford Esunt) and use the C1lenchr lcon
to select the correct date.

AutoNumber {
Text

Text

Text

Currancy

Currancy

Sumber

ot fo e i
foruta

{ 173423
edumTne 0534518 e ente
e i ot harp an Tttt

Isporttme 1732

“Ha Conteol
Hane

Generat
§ fhaw Date Ficker For dates

67 Ford Escort Silyer £3,450.00  £3,295.00 20¢a Air Conditioning Central Locking

: 69 Ford Escort Sifver £4,350.00 £5,285.00 2002 Alarm Cantral Locking Alloy Wheels
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